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WinCheck Tutorial
The Tutorial for WinCheck consists of some sample data, with the Account ID of TUT.  
When you first run WinCheck, the Tutorial data may be loaded in.  There is data 
entered for January and February of 1990.  Experiment around with the features, look
at the registers for January and February.  The statement date is set for the 1st of the 
month by default.  Change this to the 15th of the month (in the "Settings" dialog 
box), so you can look at the statements for December 1989, and January 1990.

Go ahead and write some fake checks, make that lottery check deposit you've always
wished for, and get a good feel for WinCheck before entering your own data.

The file EXP0190.TUT is the tabbed text output from the Export function.
The file EXP0190.WRI is the tabbed text output after being formatted a tiny bit by 
Write.

Overview
WinCheck is a checkbook program for Microsoft Windows Version 3.00. It allows the 
user to enter and track their transactions for a savings and a checking account.

All account information is stored with the file extension of the account ID (requested 
upon startup).  This way, if you have two accounts, you can use two sets of IDs.

Valid account ID's are 1-3 characters in length, only A-Z, 0-9 characters are allowed.



Keyboard short cuts:
F1 Help.
F2 Display Current Balance.
F3 Write Check.
F4 Checking Deposit.
F5 Bump date up  (While in Transaction Dialogs).
F6 Bump date down  (While in Transaction Dialogs).

WinCheck Version History
1.00D: Initial Release 10/31/90.
1.10A: Bug fixes 11/05/90.
1.50A: Added the ability to print checks.  

Added Memo and comment fields. 11/15/90.
1.6A: Added extra Memo Line. 12/15/90.
1.6B: Maintenance release 12/27/90.



Information not covered well in the Manual
Printing checks is not covered completely in the Registered Owner's Manual.  Here 
are the steps that should be taken when you get ready to print checks the first time:

1.  Purchase computer check forms from your favorite dealer.

2.  Start up WinCheck, do not put check forms in printer yet.

3.  If you are using the NEBS General Purpose Laser Check, part number B9039-1,  
choose
    "Load Form Template" from the WinCheck Form Designer (Activated by choosing 
"Check
    Form Printer Setup" from the "File" menu of WinCheck).  Type  LASERCHK  in the 
File
    field.  NEBS can be reached at 1-800-225-9550.

4.  If you want to create a new check form,  choose "New Form Template" from the 
WinCheck
    form designer.  Create the fields to fill in for your check (double clicking the right 
button on
    the mouse adds a new field, or press the Insert key).  Describe the attributes of the
field(s).
    Double clicking with the left button on an already existing field will allow you to 
edit the
    attributes.  Double clicking with the left button on the "workspace" of the 
WinCheck form
    designer will allow you to describe your form attributes.

    Form attributes describe the size of one  check.  If you are using a laser printer, 
describe the
    full page (unless your check form has multiple checks per page).  If you are using a
dot-
    matrix printer, describe one check.  If three checks fit on a page, you can indicate 
this.

5.  Once you have described the "rough draft", print a test form on blank paper.  Hold
the blank
    paper against your check form, and make sure all of the fields line up (you can use 
a lighbulb
    to see though the papers).  Click and drag fields to line them up.

6.  Repeat step 5 until your rough draft is OK.  If you have not saved this template 
before, choose
    "Save &Add" from the WinCheck form designer.  Describe your template however 
you want,
    and pick a filename.  If you have previously saved your file, just choose "Save".

7.  Now you are ready to print checks!

Commands
Menu choices with an asterisk* are only available at certain times.



FILE
DATA
CHECKING
SAVINGS
TOOLBOX
WINDOW
COMMON
HELP



Dialog Boxes

LOAD Prompts for Account ID to load 
new account.  Previous accounts are automatically 
saved.

TRANSACTIONS These dialogs are the actual 
transactions.

PICK A MONTH Prompts for a month to display 
a Register or Statement.

EDIT/DELETE Allows editing of Common 
Transactions.

FIND Prompts for information to find 
a transaction.

SETTINGS Prompts for program options.
CURRENT BALANCE Displays Current Balance.

FILE
Load Brings up the Load dialog to 

change accounts.
Register Brings up a check register for a 

specified month.
Statement Brings up a bank statement for 

a specified month.
Current Balance Brings up the Current Balance 

dialog.
Find Brings up the Find dialog.
Export* Exports the active register 

window to a tabbed text file which is readable by 
Microsoft Excelr, 1-2-3r, etc.  See Export.

Close* Closes the active Register or 
Statement Window.

Settings Brings up the Settings dialog.

DATA*
Header Add/Remove header from the 

active Statement/Register.
Sort ->
By Date* Sorts register by date.
By Number* Sorts register by check number.
Date,Number* Sorts register by Date, then 

Number.
Number,Date* Sorts register by Number, then 

Date.
None* No register sorting (fast 

recalcs).
Checks by Date* Sorts statement check section 

by date.
Checks by Number* Sorts statement check section 



by number.

Clear Tags selected transaction(s) as 
cleared by the bank, indicated by an asterisk.  The 
"BnkChk" or "BnkSav" columns will indicate the "Banks 
opinion" on your account.

UnClear Untags selected transaction(s).
Display Uncleared When checked, filters out 

cleared transactions from Statement.
Delete Deletes selected transaction(s).



CHECKING
Check Brings up a write Write Check 

dialog.
Deposit Brings up the Deposit dialog.
Cash Machine Brings up the Cash Machine 

dialog.
Misc Brings up the Make your own 

dialog.
XFer Savings to Checking Brings up the Transfer Savings 

to Checking dialog.
XFer Checking to Savings Brings up the Transfer Checking

to Savings dialog.
Interest accrued Brings up the Checking Interest 

Accrued dialog.

SAVINGS
Withdrawl Brings up the Savings 

Withdrawl dialog.
Deposit Brings up the Savings Deposit 

dialog.
Cash Machine Brings up the Savings Cash 

Machine dialog.
Misc Brings up the Make your own 

dialog.
XFer Savings to Checking Brings up the Transfer Savings 

to Checking dialog.
XFer Checking to Savings Brings up the Transfer Checking

to Savings dialog.
Interest accrued Brings up the Checking Interest 

Accrued dialog.

TOOLBOX
Displays the Icon-Based toolbox (mouse required).

WINDOW*
Cascade Cascades the 

Register/Statement Windows.
Tile Tiles the Register/Statement 

Windows.
Arrange Icons Arranges any minimized 

Register/Statement icons.

COMMON*
ADD -> Brings up the requested 

Common Transaction dialog. A common transaction is 



one that you make usually on a monthly basis (such as a
car payment).  You can fill in as many fields as you wish. 
Maximum 32 Common transactions.

Edit/Delete Allows you to change or delete 
Common Transactions.

Date/Transaction/$$$* These menu items represent 
the common transactions created with the Add menu 
choice. When you select these choice(s), the appropriate
transaction will appear, with the month of the date set to
the current month in the active register.  If no active 
register is present, the system clock month will be used.



HELP
Index Displays the Index.
Overview Displays the Overview.
Keyboard Displays the Keyboard Controls.
Commands Displays the Menu Commands.
About Displays the About dialog.

LOAD
This allows you to load in another account.

OK Loads new account.
CANCEL Does not load new account.

Note: Only one account can be loaded
at a time.

TRANSACTIONS
These are the checks, deposits, cash machines items, etc.  Use the TAB key to move 
between fields.

OK Adds this transaction.
CANCEL Does not add this transaction.
ANOTHER Adds this transaction, clears 

fields.

Hint: While on the Date field:

F5 Moves back a day.
F6 Moves ahead a day.

Note: A maximum of 16 transaction 
dialogs can be displayed at any one time.

The Type drop down listbox allows you to specify the nature of the transaction.  By 
default, all transactions are Personal.  To add more types, simply type the new type 
into the edit field of the drop down listbox. If the type already has been entered, it 
can be selected from the listbox.

Exported files are divided by type.

PICK A MONTH
This dialog appears when you open a Register or a Statement.  Select the month and 
year you want.

OK Opens this register/Statement.
CANCEL Does not open.





EDIT/DELETE
Displays a listbox with the Common Transactions dialog.

EDIT Edits the selected Common 
Transaction.

DELETE Deletes the selected Common 
Transaction.

LEAVE Exits this dialog.

Hint: Double Clicking on a Common 
Transaction edits it.

FIND Transaction
Allows you to search for a string or types of transactions.

Search Range Determines the dates to search.
Can be:

Search Current Month Only
Search ALL months
Search from: (fill in month/year 

-> month/year).

Trans: Determines the transaction to 
search for.

Type: Determines the type of 
transaction (Personal, etc) to search for.

Amount: Determines the amount to 
search for.  If left blank, then the search will consider any
amount (wildcard).

Check #: For checks only, indicates the 
check number.  If left blank, then the search will consider
any number (wildcard).

Keyword: For checks and Miscellaneous 
transactions only.  If the keyword in the field is in the To 
line for a check, or the Description line of a Misc, the 
search will consider it.  If left blank, the search will 
consider all descriptions (wildcard).

SEARCH Start the search.
CANCEL Don't Search.

EXPORT
When selected, a file with a extension of the Account ID is created.  The file is saved 
in a tabbed text format which is readable by most other programs such as Microsoft 
Excel, 1-2-3, etc.

The filename consists of EXPmmyy.iii, where:

mm The Month of the exported register.
yy The Year of the exported register.



iii The Account ID.

Example: EXP0990.TUT,  for September, 1990 Month, account TUT.



SETTINGS
Allows you to choose the preferences of WinCheck.

Default Register Sorting Determines how to sort the 
Register.  This can be changed for each Register window 
at any time; this is purely the initial sort method.

Default Statement Sorting Determines how to sort the 
Statement.  This can be changed for each Statement 
window at any time; this is purely the initial sort method.

Check Type Endstub checks have a different
Tab field order than conventional checks.  Otherwise, 
there is no difference.

Headings If checked, displays headings 
for the Register or Statement.

Transaction Wallpaper If checked, the transactions 
have a colorful texture (Color systems only).

Toolbox on startup If checked, the Toolbox appears 
when you start WinCheck.

Balance on startup If checked, the Balance dialog 
appears when you load an account.

OK Saves preferences.
CANCEL Uses previous preferences.

CURRENT BALANCE
Allows you to view your balance and the bank's current balance.

OK Close Balance window.



The Register
The Register sheet  is a window, which contains the transactions for the month in the 
caption.  

An optional header provides descriptions of each column:

Date The transaction Date.
# Check Number.
Description Description of transaction.
ChkAmt Amount of checking 

transaction.
ChkBal "Your Opinion" of your running 

balance.
BnkChk "Banks Opinion" of your running

balance. Only transactions cleared are figured into this 
balance.

SavAmt Amount of savings transaction.
SavBal "Your Opinion" of your running 

balance.
BnkSav "Banks Opinion" of your running

balance. Only transactions cleared are figured into this 
balance.

The Data menu allows you to specify a different sorting order.

Hints: Double Clicking on the header 
removes it.

The Register sheet allows 
multiple selections, consult your Windows manual for 
Multi-Select Listbox procedures.

Double Clicking on a 
transaction brings up the appropriate transaction dialog 
box.

Registers can be exported to a tabbed text file, readable by most spreadsheet 
programs.

The Statement
The Statement sheet is a window, which contains the transactions for a period of one 
month, starting on the date specified in the Settings Dialog.

An optional header provides descriptions of each column:

Date The transaction Date.
# Check Number.
Description Description of transaction.
ChkAmt Amount of checking 

transaction.
SavAmt Amount of savings transaction.

Hints: Double Clicking on the header 



removes it.
The Statement sheet allows 

multiple selections, consult your Windows manual for 
Multi-Select Listbox procedures.

Double Clicking on a 
transaction brings up the appropriate transaction dialog 
box.

Statements can be exported to a tabbed text file, readable by most spreadsheet 
programs.



Common Transactions
Common Transactions are those which are made regularly, such as rent, mortgage, 
utilities, food, etc.  WinCheck allows you to define up to 32 "templates", or "Common 
Transactions", which allow you to quickly enter the transaction.  Create templates 
using the "Add" menu choice, change or delete them through the Edit/Delete dialog.

As you add common transactions, they will be added to the Common menu.  
Choosing these transactions immediately brings up a filled transaction dialog which 
you can change if necessary before saving by pressing OK.

Hints and Tips
Take advantage of the Misc transaction.  Direct Deposits, automatic withdrawls, 
service fees, and more can be entered here.

Take advantage of the Type field in the Transaction dialogs. You can accurately and 
carefully track your finances this way.

Register this product!  By registering this product, you will keep informed about 
updates, and you will keep me motivated to make more nifty windows apps.

License Information

WinCheck 
Copyright © 1990 by Dave Edson
All rights reserved.

SOFTWARE LICENSE

WinCheck is not and has never been public domain software, nor is it free software.

Non-licensed users are granted a limited license to use WinCheck on a 21-day trial
basis for the purpose of determining whether WinCheck is suitable for their needs.
The use of WinCheck, except for the initial 21-day trial, requires registration.  The use
of unlicensed copies of WinCheck by any person, business, corporation, government
agency or any other entity is strictly prohibited.

A single user license permits a user to use WinCheck only on a single computer.
Licensed users may use the program on different computers, but may not use the
program on more than one computer at the same time.

No one may modify or patch the WinCheck executable files in any way,  including but
not  limited  to  decompiling,  disassembling,  or  otherwise  reverse  engineering  the
program.



A limited license is granted to copy and distribute WinCheck only for the trial use of
others, subject to the above limitations, and also the following:

1) WinCheck must be copied in unmodified form, complete with the file containing
this license information.

2) The full machine-readable WinCheck documentation must be included with each
copy.

3) WinCheck may not be distributed in conjunction with any other  product with out a
specific license to do so from Wilson WindowWare.

4) No fee, charge, or other compensation may be requested or accepted, except as
authorized below:

A)  Operators  of  electronic  bulletin  board  systems  (sysops)  may  make  WinCheck
available for downloading only as long as the above conditions are met.  An overall or
time-dependent charge for the use of the bulletin board system is permitted as long
as there is not a specific charge for the download of WinCheck.

B)  Vendors  of  user-supported  or  shareware  software  approved  by  the  ASP  may
distribute WinCheck,  subject to the above conditions,  without specific permission.
Non-approved  vendors  may  distribute  WinCheck  only  after  obtaining  written
permission from Wilson WindowWare.  Such permission is  usually granted.   Please
write for details (enclose your catalog).  Vendors may charge a disk duplication and
handling fee, which, when pro-rated to the WinCheck product, may not exceed eight
dollars. 



LIMITED WARRANTY

Wilson WindowWare guarantees your satisfaction with this product for a period of 90
days from the date of original purchase.  If you are unsatisfied with WinCheck within
that time period, return the package in saleable condition to the place of purchase for
a full refund.

Wilson WindowWare warrants that all disks provided are free from defects in material
and workmanship, assuming normal use, for a period of 90 days from the date of
purchase.

Wilson WindowWare warrants that the program will perform in substantial compliance
with the documentation supplied with the software product.  If a significant defect in
the product is found, the Purchaser may return the product for a refund.  In no event
will such a refund exceed the purchase price of the product.

EXCEPT AS PROVIDED ABOVE, WILSON WINDOWWARE DISCLAIMS ALL WARRANTIES,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO
THE  PRODUCT.   SHOULD  THE  PROGRAM  PROVE  DEFECTIVE,  THE  PURCHASER
ASSUMES THE RISK OF PAYING THE ENTIRE COST OF ALL NECESSARY SERVICING,
REPAIR, OR CORRECTION AND ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES.  IN
NO EVENT WILL WILSON WINDOWWARE BE LIABLE FOR ANY DAMAGES WHATSOEVER
(INCLUDING  WITHOUT  LIMITATION  DAMAGES  FOR  LOSS  OF  BUSINESS  PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING
OUT  OF  THE  USE  OR  THE  INABILITY  TO  USE  THIS  PRODUCT  EVEN  IF  WILSON
WINDOWWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Use  of  this  product  for  any  period  of  time  constitutes  your  acceptance  of  this
agreement and subjects you to its contents.

U.S. GOVERNMENT RESTRICTED RIGHTS

Use, duplication, or disclosure by the Government is subject to restrictions as set
forth in subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software
clause  at  252.227-7013.   Contractor/manufacturer  is  Wilson  WindowWare  2701
California Ave SW /suite 212/ Seattle, WA 98116

TRADEMARKS

IBM,  PC/XT,  PC/AT,  and  PS/2  are  registered  trademarks  of  International  Business
Machines Corporation.

Microsoft and MS-DOS are registered trademarks of Microsoft Corporation. Windows is
a trademark of Microsoft Corporation.

Pagemaker is a trademark of Aldus Corporation.

BARBIE is a registered trademark of Mattel, Inc.

Command Post is a trademark of Wilson WindowWare.

WinCheck is a trademark of Dave Edson


